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Figure 1: Bookmark options
By Robert P. Mohr, Pittsburgh
Chapter Senior Member
Turning your Word documents into
PDF (Portable Document Format)
files is an excellent way to share
your documents with readers across
a wide spectrum of operating
systems and hardware platforms.
Adobe’s free Acrobat Reader makes
it possible to read PDF files on
machines running Windows, UNIX,
and Apple OS. A version of the
Reader is also available for handheld
computers. So, how do you turn
those beautifully crafted Word
documents into PDF files?

The process boils down to
printing the Word document to a
postscript file and then “distilling”
it to a PDF. Although there are a
few shareware utilities and thirdparty services that can create PDF
files for you, I prefer to use Adobe
Acrobat for all of my PDF work. It
automates the distillation process,
integrates well with Microsoft
Office, and is the best way to
customize a PDF file. More
information is available at
http://www.pdfzone.com.
See PDF Primer, page 11
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General Information
Lines & Letters is published bimonthly
for members of the Northeast Ohio
Chapter of the Society for Technical
Communication.
This newsletter invites writers to submit
articles for publication via e-mail.

Chapter Calendar
June 13: Networking Lunch
Winking Lizard, 1615 Main St. (RT 303), Peninsula.

July 12: Networking Lunch
Weia Teia, Great Northern Blvd. in Great Northern Mall,
North Olmsted.

Deadlines
Deadlines for submissions are as follows:
July/Aug
Sept/Oct

Northeast Ohio Chapter

Submit by 7/01/02
Submit by 9/01/02

Advertising Sizes/Rates
Full col. (2.25 x 10 in.)
1 issue – $35.00
2 issue – $66.50
3 issue – $94.50

Half col. (2.25 x 5 in.)
1 issue – $25.00
2 issue – $47.50
3 issue – $67.50

Quarter col. (2.25 x 2.5 in.)
1 issue – $15.00
2 issue – $28.50
3 issue – $40.50
Note: By submitting an article, you
implicitly grant a license to this
newsletter to run the article and for
other STC publications to reprint it
without permission. Copyright is held by
the writer. In your cover letter, please let
the editor know if the article has run
elsewhere, and if it has been submitted
for consideration to other publications.
Unless otherwise noted, copyrights for
all newsletter articles belong to the
authors. Design and layout of this
newsletter are copyright STC, 2001.
Reprints from the printed newsletter are
allowed if permission is obtained from
the original author, credit is given to the
author and the newsletter, and a copy of
the reprint is sent to both the current
newsletter editor and author. Photocopying of portions of the newsletter is
permitted, provided this is done for
nonprofit, educational purposes. For
other uses of newsletter material, please
contact the editor for permission in
advance.

August 22: Networking Lunch
Bronte at Joseph-Beth Booksellers, Shaker Square,
Cleveland.
NOTE: Chapter networking lunches begin at noon. If you
plan to attend, contact Jill McCauslin at
jmccauslin@radcominc.net or Angie Dianetti at
adianetti@radcominc.net so they can save a seat for you.

Membership News
New NEOSTC members, membership status changes, and more.

Congrats on a Great Job!
Senior member Patricia A. Toth
recently published a book review in
Technical Communication.
The book reviewed was In Your Face
Too! The Best Interactive Interface
Designs.
Look for it in your May 2002 issue of
Technical Communication or online
at http://www.techcomm-online.org/
issues/v49n2/reviews/0515-8.html.

Welcome to New Members
The spring brought us four new
members. Please welcome:
- Nora Ebie
- Steven P. Olay
- Erika M. Weliczko
- Candace Wintering
We would also like to welcome
transfer member Susan L. Schultz.
We hope to see you at our upcoming
networking lunches this summer.
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STC Membership Counts
April membership counts for the
chapter and for the Society come to:
Chapter: 177
Society: 19,052

You’re a Member of a
Chapter of Excellence!
For the second year in a row, the
Northeast Ohio Chapter won Chapter
of Excellence at the International
Conference. To be recognized for this
award, the chapter must complete an
in-depth list of member services and
be recommended by its region
director-sponsor. Way to go, NEO!W
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On The Front Lines
Student Competition
Winner Receives
Honorable Mention
Mikael Vincent Tien Doe Chan, first
place winner of the NEOSTC student
compeition, received an Honorable
Mention in the International
Competition for his paper “A Brief
Look into Dark Matter: The
Missing Mass.” Mikael is a
student at Westgate
Mennonite Collegiate in
Winnipeg, Manitoba,
Canada, and the
sponsoring teacher
was Janis Thiessen.
Congratulations to Mikael
and Janis, and thanks to
NEOSTC senior member Bege
Bowers and the judges.
For info about our next student
competition, go to http://
www.neostc.org/info/STCohio02.pdf.

April Meeting Survey
Results: Our Greatest
Work Challenges
The April meeting featured Leslie
Yerkes and her discussion on
conquering our greatest work
challenges. For the meeting wrap-up,
see page 12. Special thanks to Kim
Lindsey for compiling this list.
Time and Project Management
- Finding work and clients.
- Managing and prioritizing
multiple projects simultaneously
and efficiently.
- Staying motivated — focused on
one project at a time when there
are a dozen or so projects
looming overhead.
- Balancing home and work time.

Communication
- Dealing with a lack of
communication between
individuals and groups
(deliberate and unintentional)
that results in different
individuals and
groups doing the
same thing in
different ways, doing
their own thing,
or reinventing the
wheel. This results in no
defined standards (or
defined standards that are
being ignored) or sense of
direction.
- Status levels — keeping
everyone up-to-date.
- Keeping everyone informed on
the structure of the project.
Knowledge
- Keeping up with new technology
and techniques.
- Being knowledgeable about any
type of documentation needs a
client may have. From
developing user manuals, to
maintaining Web sites, to
updating help systems. As a
consultant, I sort of have to be a
jack-of-all-trades.
Resources
- Getting all the information I need
about a product.
- Availability of subject matter
experts (SMEs), technical
support, etc.
- Getting feedback.
- Getting valuable information on
reviews instead of vague
comments.
- Getting people to take the time to
do a real technical edit; everyone
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is usually too busy.
- Having to interview clients’
employees who aren’t willing to
answer questions and the
manager offers no support.
- Getting people to meet their
deadlines so I can meet my
deadlines.
- Trying to obtain approval
signatures from people in a
different city. Before releasing a
document for distribution, we
need to obtain approval
signatures from various
technical and business experts.
Office Interfacing
- Standards.
- Dealing with various personality
types, especially those who
think that you can’t take your
work seriously unless you’re
glum. Life should be a jolly
thing!
- Cooperation.
- Teamwork with individuals who
don’t see the value in the
project/company.
- Figuring out what an “open
door policy” really means.
- Discerning corporate culture
and the real power structure (as
opposed to the organizational
chart).
- Being stifled or stuck and unable
to work out from under
management thumbs.
- Convincing co-workers (all
engineers) that I’m more than a
Microsoft Word “expert.”
- Dealing with challenging coworkers.
- As a consultant, I do not feel
that I am really part of the
“gang” at work.
- Co-workers constantly coming
up to you to socialize.W
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2002-2003 Chapter Election Results
The Northeast Ohio Chapter of the
Society for Technical Communication
is pleased to announce the results of
its election for 2002-2003.
Executive Board
President

Beth Williams

Vice President

Lori Klepfer

Secretary

Kim Lindsey

Treasurer

Dennis Verbiar

Immediate Past
President

Kris Henige

Employment

Myron Shawala

Membership

Tricia Olesky

Networking
Lunches

Angie Dianetti

Newsletter

Sharon Ambro
Karla Caldwell

Secretary: Kim Lindsey
ke.lindsey@att.net

Nominating

Kris Henige

Treasurer: Dennis Verbiar
cverbiar@centurytel.net

Programs

Stephanie Webster

Public Relations Jessica Hendricks
Technicom
Conference

Maria Hlas
Jill McCauslin

Committee Managers

Web Site

Ken Rogers

Contracting &
Independent
Consulting SIG

Officer and manager contact
information will appear in the July/
August edition of Lines & Letters. W

Joe Piar

2002-2003 Society Election Results
The Society for Technical
Communication is pleased to
announce the results of its election for
2002-2003.

Director-Sponsor, Region 1
Jonathan W. Baker, a senior member
with the Boston chapter, has been
elected director-sponsor of Region 1.

President
Edward J. See, a senior member with
the New York Metro chapter, assumes
the office of president after a year of
service as first vice president.

Director-Sponsor, Region 5
Linda L. Oestreich, a fellow with the
Houston chapter, has been elected
director-sponsor of Region 5.

First Vice President
Thea Teich, a senior member with the
Southwestern Ohio chapter, assumes
the office of first vice president after a
year of service as second vice
president.
Second Vice President
Andrea L. Ames, an associate fellow
with the Silicon Valley chapter, has
been elected second vice president.
Secretary
Andrew Malcolm, a fellow with the
Rochester chapter, has been elected
secretary.

Northeast Ohio
Chapter STC Officers

Director-Sponsor, Region 7
Rahel Anne Bailie, a senior member
with the Canada West Coast chapter,
has been elected director-sponsor of
Region 7.
Nominating Committee
M. Katherine Brown (Kit), a senior
member with the Snake River chapter,
has been elected to serve a two-year
term on the nominating committee.
Nominating Committee
Nan J. Fritz, an associate fellow with
the Boston chapter, has been elected
to serve a two-year term on the
nominating committee. W
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President: Kris Henige
khenige@parker.com
Vice President: Beth Williams
bwilliams@software.rockwell.com

Im. Past President: Jill McCauslin
jmccauslin@radcominc.net
Membership: Michelle Kastro
mpkastro@core.com
Mentoring: Rick Elliott
rellakrn@att.net
Programs: Stephanie Webster
swebster@ppipubs.com
Public Relations: Linda DeLonais
ldelonais@accinternet.com
Employment: Elizabeth Simeral
elisim@nls.net
Myron Shawala
myron.shawala@software.rockwell.com
Competitions: Jeanette Evans
evans24408@aol.com
Cheryl Bennett
sdblue@earthlink.net
Carol MacKay
CMacKay224@aol.com
Gail Pogue
poguega@aol.com
Student Competition: Bege Bowers
bkbowers@cc.ysu.edu
Networking Lunches: Angie Dianetti
adianetti@radcominc.net
Web Site: Kristen Jackson
kjackson@radcominc.net
Mark Blake
mbimages@hotmail.com
CIC SIG: Barb Philbrick
caslons@aalltel.net
Newsletter: See cover
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Regional
Opportunities
Workshops, conferences, and events in and around Ohio.

How to Design a Training
Program (So That Anyone
Can Present It
Successfully)
Seminar By: Padgett-Thompson Oneand Two-Day Seminars
Phone: 800-255-4141
Location: Cleveland
Date: June 13
Cost: $179
Web URL: http://www.ptseminars.com
Learn to design training courses and
develop training materials that are
incredibly easy to understand even
when you’re not the person
presenting them.
What you will cover:
- Identifying performance gaps
- Examining learner analysis
methods
- Investigating task analysis
techniques
- Creating learning objectives
- Determining training
effectiveness
- Developing appropriate training
products
- Designing effective training
- Piloting new training programs
- Avoiding unnecesary training
- Applying the learner analysis
process to your target audience
- Ensuring your training
accomplishes the intended
results
- Organizing course content for
flow and timing
- and more

Web Site Concepts
Class By: Lakewood Public Library
Phone: 216-226-8275
Location: 15425 Detroit Ave.,
Lakewood - Library Technology
Center
Date: June 21, July 26, or Aug 23 from
7 PM - 9 PM
Cost: Free
Web URL: http://www.lkwdpl.org/
Learn the elements of Web sites
including tables, frames, and image
maps.

HTML Authoring
Class By: Lakewood Public Library
Phone: 216-226-8275
Location: 15425 Detroit Ave.,
Lakewood - Library Technology
Center
Date: June 22, July 27, or Aug 24 from
10 AM - Noon
Cost: Free
Web URL: http://www.lkwdpl.org/
Get an overview of HTML and
Javascript programming languages
and learn how to make a Web page.

Creative Graphics
Class By: Lakewood Public Library
Phone: 216-226-8275
Location: 15425 Detroit Ave.,
Lakewood - Library Technology
Center
Date: June 22, July 27, or Aug 24 from
2 PM - 5 PM
Cost: Free
Web URL: http://www.lkwdpl.org/
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Learn how to scan and manipulate
digital pictures. Bring a picture to scan
and a computer disk for your work.

Brown Bag Seminars
Build an Organization
Seminar By: Cleveland Public Library
Phone: 216-623-2800
Location: 325 Superior Ave., N.E.,
Cleveland
Date: Thursday, June 20 - Noon
Cost: Free
Web URL: http://www.cpl.org/
See below for description.

Legal Organization of Your
Business
Seminar By: Cleveland Public Library
Phone: 216-623-2800
Location: 325 Superior Ave., N.E.,
Cleveland
Date: Thursday, July 11 - Noon
Cost: Free
Web URL: http://www.cpl.org/
An expert panel
of successful
retired
executives from
the Business
Advisers of
Cleveland will
present these
free
informative
seminars to answer your questions
and offer advice. Join us in Room 218E
of the Louis Stokes Wing, (2nd floor
north), at noon. Refreshments will be
provided. W
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Chapter Members Bring Home Awards The Esoteric
Fifteen Awards Given to Competition Winners
The May awards banquet, held on
Friday the 17th, brought members
from across northeast Ohio together
to recognize some exceptional
accomplishments.
The NEOSTC topped off at 15 awards
this year in the online and print
competitions.

Laurie Harrison

Laurie Harrison and
Douglas Tittle for PPG
Accu-Systems
Interface Installation
and Troubleshooting
Manual
Lori Moreland and
Tony Molica for
DeviceNet Selection
Guide

Online Competition - Award of
Excellence
Lori Moreland

Lisa Adair for
Compact DeviceNet
Adapter User Manual

Technical Publications
Competition - Award of Merit
Peggy Coyne

June Muhic

Peggy Coyne and June Muhic for
Marconi Medical Systems IntelliView
Web Help
Gigi Kolt for RSLogix 5000 Online Help
System

Jennifer Square

Robert G. Young for
CourtView 2000 User
Guide

Technical Publications
Competition - Award of
Distinguished Technical
Communication
Scott Mills for ControlLogix
Redundancy System

Robert G. Young

Scott Mills for ControlLogix
Redundancy System

Maria Hlas and Douglas
Tittle for PPG AccuSystems System
Administrator’s Guide

Robert G. Young for
JuryView 2000 User
Guide
Margaret Znidarsic for
Electronic Report
Solution (ERS) Manual

Best of Show

Technical Publications
Competition - Award of
Excellence

David Donaldson,
Jennifer Square, and
Jack Wellmerling for
National Billing Platform
Intranet Documentation
Set

Margaret Znidarsic

Lisa Adair for I/O
Products System
Overview

Lori Moreland, Jonathan Bradford,
and Claudia Griesmer for DeviceNet
Communication Card Installation
Instructions

Laurie Harrison and Thomas Schmidt
for GED Application Table for 3M
Accentrim Products Manual W

Maria Hlas
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By Karla Caldwell, Co-Editor
Another STC year has passed and
Sharon and I have agreed to stay on
as Lines & Letters editors. I can’t say
officially just yet, but I think we’re
going to have two new volunteers on
the team as well. Keep your eyes
peeled for the July/August issue to
find out more.
Our big news for this issue is that we
brought back an Award of Merit for
the newsletter at the international
competition. We’d like to thank you all
for your support and encouragement
this year — we couldn’t have done it
without you!
Next year, we plan to enter the
competition again, but to make our
efforts a success, we’re going to need
your help too. One of the criteria for
winning an Award of Excellence is to
publish letters to the editors in each
issue.
With that in mind, we need to hear
from you! Tell us how we’re doing. Let
us know if there’s somthing you’d like
to see. Share your favorite technical
communication resources.
And above all, remember that this is
YOUR newsletter! W
Dear editors,
The Competitions Committee would
like to offer a special thank you to
RADCom Inc. for providing the laptop
computers for the display of the
online entries at the banquet. The
company was inadvertently left off the
acknowledgements section of the
awards banquet program.
Gail Pogue

Northeast Ohio Chapter

Society for Technical Communication

Banquet Recognizes Hard Work,
Dedication by Member Volunteers

How Much is a
Degree Worth?
Earning a professional or doctorate
degree could be worth $2.8 million
in added income over 40 years.

By Karla Caldwell,
Co-Editor
Once again, the
Northeast Ohio
Chapter has received
a Chapter of
Excellence award,
but that would never
have been possible
without the hours of
hard work donated
by our member
volunteers.

Degree Income
- Professional or doctorate
degree: $2.8 million
- Master’s degree: $2.3 million
- Bachelor’s degree: $2 million
- Two-year vocational degree:
$1.5 million
- High school diploma: $369,818

Each year, the
Vice president Beth Williams (left) recognizes Competitions
chapter recognizes
Committee Members. From left to right, Cheryl Bennett, Carol
two special
MacKay, Gail Pogue, and Lori Klepfer. Not pictured: Jeanette
volunteers, without Evans
whom we couldn’t
have made it to where we are today.
Last, but not least,
These members are awarded the
the Distinguished
Distinguished Chapter Service award
Chapter Service
and the Volunteer of the Year award.
award was
presented to a man
This year, we also chose to present a
who has logged
new Committee of the Year award. The
hundreds, if not
Competitions Committee, made up of
thousands, of
Bob Dianetti
Jeanette Evans, Cheryl Bennett, Lori
volunteer hours for
Klepfer, Carol MacKay, and Gail
the NEOSTC. Bob Dianetti has made
Pogue, put forth an exceptional effort
numerous contributions to the
in preparing and presiding over our
chapter, including finding a host for
chapter’s online and technical
the chapter’s Web site, working
publications competitions and in
behind the scenes on several
planning this year’s awards banquet.
committees (sometimes at once!),
serving in chapter offices, and being
This year’s Volunteer of the Year is
an all-around great role model.
Stephanie Webster, manager of the
Programs Committee. Stephanie
We’d like to congratulate the members
arranged the details of our excellent
mentioned here as well as all the other
series of meetings this year, from
members who volunteered their time
setting up locations and dinner menus and efforts to make the NEOSTC one
to arranging speakers and planning
excellent chapter. W
topics.
Note: The photos on pages 6 and
And, we can rest assured that we’ll
7 were taken at the May 2002
have the same level of quality and
awards banquet by Karla
exciting programs next year with
Caldwell and are copyrighted
Stephanie’s continued efforts as the
2002 by the NEOSTC.
Programs Manager.
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Source: Employment Policy
Foundation analysis of Bureau of
Labor Statistics (BLS) Current
Population Survey W

Free
M e etin g o ror
F re e Meeting
N e tw o rking
Networking
L u n ch!
Lunch!
Winners
of the
competition survey
drawing for free admission to a
meeting or a networking lunch:
Dennis Verbiar
Carol MacKay
Gigi Kolt
Congratulations and thanks to
all who participated! W

Mark Your
Calendar
The Region 4
Conference and Annual
Leadership Workshop will be
hosted by the Central Ohio
Chapter on November 8 - 9,
2002. Don’t miss out! W
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Book Review - Hamlet on the Holodeck:
The Future of Narrative in Cyberspace
By Al Brown, Philadelphia Metro
Chapter Member
Reprinted from the Mar/April 2002
issue of News & Views Online. http://
www.stcpmc.org/newsviews/index.asp
Janet Murray aspires to be the
Aristotle of the Information Age. Just
as the latter’s Poetics codified
classical Greek drama, Professor
Murray attempts to identify the
unique storytelling qualities of the
emerging interactive digital
technologies and to
suggest how they will
fit into the human
narrative tradition.
According to Professor
Murray, there are four
principal properties of the digital
medium that make it “a powerful
vehicle for literary creation,” namely
that digital environments are
procedural, participatory, spatial, and
encyclopedic. Of these properties,
perhaps the most important are that
computers function by process, rather
than by events (as traditional
narratives do); and that the audience
(or user) can influence the process.
The ability to create a believable
visual environment and to fill it with
objects based on information from
worldwide sources result from
advances in technology that make
large-scale information processing
possible. The core of Hamlet on the
Holodeck elaborates on these
properties.
From the audience’s point of view, the
technological characteristics of digital
literature resolve into a similar set of
qualities that the author of a digital
narrative must consider. The first is
the audience’s ability to immerse itself
into the narrative and accept it—at
least temporarily—as reality. This can
occur through role playing, graphic

avatars, or other means. Second is the
sense of agency: The feeling on the
part of the audience that it can change
the course of events. This seems to be
the most problematic issue: In an
electronic narrative, how much control
should be ceded from the author
(whatever that means in this context)
to the reader/audience? Finally, digital
environments are capable of
transformation:
The computer captures
processes, and it therefore is
always suggesting processes to
us even when it is just
displaying information.
Anything we see in digital
format — words, numbers,
images, moving picturesbecomes more plastic, more
inviting of change.
Interactive narratives, simulations,
and games can be designed to change
point of view, setting, character, and—
especially significant for narrative—
outcome.
Storytelling techniques have always
changed with technology—writing,
printing, movies, TV—and each
change has begun with the imitation
of previous technologies until the
possibilities of the new were
recognized and exploited. As a
corollary, those who were brought up
with the old technology were
convinced that the new would bring
civilization down around their
shoulders. The issue, as Murray
points out, is that all of these
storytelling modes, from bards to
computer games, have drawn people
into a form of what we used to call
willing suspension of disbelief and
now call virtual reality. This has
always been perceived as dangerous
—look at what it did to Don Quixote.
She argues that regardless of the
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technology, storytelling serves the
same function:
Narrative beauty is independent
of medium. Oral tales, pictorial
stories, plays, novels, movies,
and television shows can range
from the lame and sensational to
the heartbreaking and
illuminating. We need every
available form of expression and
all the new ones we can muster
to help us understand who we
are and what we are doing here.
That’s all very well for our souls, but
the question, as always here, is what
good does this do us as technical
communicators? Many of the insights
into the digital world help us who
have to document it, or at the very
least work in it. The notions of
process, immersion, agency, and
transformation give us fresh ways of
looking at how to explain our
products. It doesn’t really matter that
the five years since the book was
written have dated the examples and
predictions. Who could have thought
in 1997 that DVDs would provide the
viewing options that Murray expected
of interactive television? The book’s
Web site, http://web.mit.edu/jhmurray/
www/HOH.html, may have some
broken links, but it does show the
direction of current thinking about
electronic literature.
In short, we must understand the
properties and organizational
principles of the new information
media if we are to use them ourselves
and explain to others how to use them.
Hamlet on the Holodeck is a
stimulating place to start. W
Murray, Janet H., Hamlet on the
Holodeck: The Future of Narrative
in Cyberspace. Cambridge: MIT
Press, 1998 [1997]. ISBN 0-26263187-3 (paper), 336 pages, $21.95.
Al Brown is Editor/Team Leader at
Oki Data. He has a Windows
daughter and a Mac son.
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www.TechcommCareers.org Provides Online
Job Resource for Technical Communicators

XML Training Offer
for STC Members
ClearlyOnline, Inc., is pleased to
announce “XML for Writers,
Editors, and Publishers,” a two-day
course that presents XML from the
perspective of those who work
with print and online content. It
focuses on and explains the XML
concepts and issues relevant to
writers and publishers, rather than
programmers. The course gives
content professionals, who are in
an excellent position to guide XML
initiatives within their organization,
the basic understanding needed to
assess the benefits of XML and
implement an XML system.

Techcomm Careers Home Page
By Karla Caldwell, Co-Editor
Funded by a grant from the STC, the
Techcomm Careers site (http://
www.techcommcareers.com) has been
developed through the cooperation of
one STC general chapter and two
student chapters including Ohio’s
own Cedarville University Chapter.
The purpose of the site is “to
introduce you to the range of careers
available in the field of technical
communications and provide
information about the skills needed in
today’s and tomorrow’s workplaces
and academies.”
Challenges cont., from back
communication and are more
attitudinal than concrete.
Stage 5 – Brainstorm ideas to
minimize the impact of restraining forces
Because of time, we were unable to
perform stage 5, but Yerkes suggested
this for another NEOSTC meeting. She

With sections on career paths,
education, profiles, resources, and job
searching, the site is packed with
ideas and experiences that will benefit
not only people new to the field, but
also seasoned veteran technical
communicators looking for a change
in pace.
For example, the Job Search section
contains links to online databases of
jobs, tips, and ideas for portfolio
development, resources for finding
internships, and even a list of
software packages that technical
communicators should be familiar
with. W
proposed that we come up with the
top three ways for minimizing the
effects of restraining forces and then
work as a team to reduce these in the
technical communication profession in
northeast Ohio.
Leslie Yerkes is president of Catalyst
Consulting Group in Cleveland and
helps companies with leadership
coaching, managing change, team
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As a special introductory offer to
STC members, ClearlyOnline is
discounting registrations made by
June 11 for the course scheduled in
Pittsburgh, PA, on June 24-25: 15%
discount for individuals ($680
instead of $800) and 35% for
groups of three or more ($520
instead of $800). Please see http://
clearlyonline.com/xml/training.html
for more information or e-mail
xml@clearlyonline.com if you want
to take advantage of the June
discounts.
If you are not able to attend the
course in June, see the Web site
for a list of other course dates and
locations. You can also call
ClearlyOnline at 724-942-1912 for
more information or to register. W
building, and training. She is a
lecturer and keynote speaker, has
taught at several local universities,
and serves on the faculty of the
Weatherhead School of Executive
Education. Yerkes also co-authored
the book 301 Ways to Have Fun at
Work.
See page 3 for results of Yerkes’s
survey for NEOSTC members. W
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President’s Notes
Our chapter was
well-represented at
the recent STC
International
Conference in
Nashville.
Speakers from our
chapter included
Mike Bates, Audrey Cielinski-Kessler,
Angie Dianetti, and Jill McCauslin.
Bege Bowers was recognized as a new
Associate Fellow at the Honors
Banquet.

I will become Immediate Past President
and Nominating Committee Manager
next year, and I know the chapter is in
good hands with incoming President
Beth Williams and incoming Vice
President Lori Klepfer at the helm. We
are also fortunate to have chapter
member Mike Bates continuing as our
Region 4 Director-Sponsor.
A list of other committee managers for
2002-2003 is on page 4.

......

To view handouts and other materials
from the sessions, go to http://
www.stc.org/49thConf/
Session_Materials/show_IE.asp.

......
The following committee managers
and members are stepping down from
chapter service this year:
•
•
•
•
•
•
•
•
•
•
•

Barb Philbrick, CIC SIG
Jeanette Evans, Competitions
Cheryl Bennett, Competitions
Carol MacKay, Competitions
Gail Pogue, Competitions
Elizabeth Simeral, Employment
Michelle Kastro, Membership
Heidi Fronheiser, Membership
Linda DeLonais, Public Relations
Kristen Jackson, Web Site
Mark Blake, Web Site

My thanks to them for their efforts.
Former Mentoring Manager Rick
Elliott will become a member of the
Web Site committee, where he will be
joined by Brian Baddour and new
committee manager Ken Rogers.
Immediate Past President and
Nominating Committee Manager Jill
McCauslin will co-manage our spring
2003 Technicom conference with past
president Maria Hlas.

As our Award of Excellence indicates,
we’ve accomplished a lot this year,
including the following new
initiatives:
• Started a listserv
• Successfully nominated our first
Associate Fellow, Bege Bowers
• Awarded three free international
conference registrations
• Developed a strategic plan
• Created meeting evaluation cards
• Created chapter business cards
that members can give to
prospective members
• Developed an e-mail list to keep
members informed
• Held a charity food drive at our
holiday meeting
Be sure to join us at our networking
lunches this summer, and look for our
evening meetings to resume in
September.
It’s been an honor serving as your
president this year. Have a great
summer! W
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Techcomm
Trivia!
Can you name the prime time TV
character who describes him- or
herself in the following way?
“I’m a
struggling short
story writer who
makes a living
writing
technical
manuals for a
giant and
totally
indifferent company. I like to tell
stories about my life, but not just the
stuff that actually happens, but also
what could have happened, what
should have happened, and
sometimes what I’m thankful didn’t
happen. Actually, those are the best
ones but can’t be seen on network
television. How much is cable per
month?
Oh, I also have conversations with
the dead founder of the company - but
that only happens some of the
time…”
If you can, and you’re the first one to
e-mail us the answer along with one
topic you’d like to see covered in the
upcoming volume of Lines & Letters,
you could win an STC magnetic
poetry set.
Send e-mails to Sharon and me at
lleditors@hotmail.com. Make sure to
include your name and mailing
address so that we can contact you if
you win.

Good luck!

Note: The chapter president and newsletter
editors cannot participate.

Northeast Ohio Chapter
PDF Primer cont., from cover
After you install Acrobat, you’ll
notice when you open Word that a
two-icon toolbar has been added.
There is also an Acrobat menu option
on the main menu bar. Both of these
are supported by the PDFMaker suite
of macros that are installed with
Acrobat. (A similar toolbar and menu
option is also installed in PowerPoint
and Excel.) The Acrobat menu option
allows you to
configure the PDF
output based on
attributes in your
Word document.
For example,
selecting the
Change Conversion
Settings option on
the drop-down menu displays the
Settings dialog box. Figure 1, on page
1 shows the Bookmark options.
The term Bookmark here is different
from a Word bookmark. PDF
bookmarks appear as dynamic table of
contents entries when viewed in the
Acrobat Reader. They can be based
on your document’s heading or style
structure. Clicking the Display
Options tab lets you control how links
and bookmarks will be displayed when
the PDF file is opened.
Once saved, the settings remain in
effect until you change them. You may
find a need to make changes to these
on a document-by-document basis.
The Settings, Security, and Office tab
settings are a bit more global in scope.
I set them once and haven’t had a
need to change them since. To
generate a PDF from a Word
document, simply click the Convert to
Adobe PDF icon on the toolbar.
PDFMaker prompts you for the PDF’s
file name and creates the file. If you’ve
selected the View Result in Acrobat
option from the Acrobat drop-down
menu, then Acrobat is automatically
called by PDFMaker and displays the
new PDF.

Society for Technical Communication
Once the file is in Acrobat, there are a
myriad of tools with which you can
put the finishing touches on your PDF
file. Here are just a few:
• Select File > Document Security
from the main menu to protect
the finished file from tampering.
Using password protection, you
can prevent readers from
printing, copying, or altering the
contents.
The Acrobat
menu option
allows you to
configure the PDF
output based on
attributes in your
Word document.

• Select File > Document Options
to add document summary
information and specify the
appearance of the PDF when it is
opened.
• Select one of the Insert, Delete,
Extract, or Replace pages under
the Document menu option to
perform those operations on one
or more pages. These are
especially useful when compiling
a single PDF file (such as a book)
from several (chapter) PDF files.
Use the Crop and Rotate options
to alter a page’s appearance.
• Add a bookmark to the
Bookmarks window at any time
by selecting text from the
document (using the Text Select
Tool icon) and pressing Ctrl+B.
The bookmark entry can be
further modified by right-clicking
on it and altering its properties.
• Delete a bookmark by rightclicking on it and selecting
Delete from the shortcut menu.
• Rearrange the bookmarks and
change their hierarchy by
clicking on a bookmark and
dragging it to the new location.
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You can also add several dynamic and
custom effects to a PDF file:
•
•
•
•
•
•
•

Pop-up notes
Graphics
Highlighted text
Hyperlinks
Video clips
Input forms
Javascripts

If you want to create a PDF from an
existing paper document, you’ll have
to scan it:
Select File > Import > Scan.
When scanned, the resulting PDF is
stored as an “image” rather than text.
You can save the PDF as is, but it will
not be searchable. In order to convert
the scanned file into one that is textbased and searchable using Adobe
Acrobat 5.0, you’ll need to download
and install the Paper Capture utility.
You can obtain it at:
http://www.adobe.com/products/
acrobat/pluginreg.html
After installation, a Paper Capture
option appears in the Tools dropdown menu. Selecting the paper
capture option invokes an optical
character recognition engine that
scans through the file and creates
words and numbers from the image.
Graphics are ignored. The accuracy of
the conversion is usually very good,
but you should review the contents
before distributing the file.
Regardless of how you create your
PDF files, or the modifications you
make to them, PDF is an ideal way to
distribute documents to a diverse
audience. W
Bob Mohr can be reached via email
at: rpmohr@writemohr.com
Reprinted from the May 2002 issue of
The Pittsburgh Chapter’s newsletter,
The Blue Pencil.

Northeast Ohio Chapter STC
4570 Lander Rd.
Orange, Ohio 44022
http://www.neostc.org

April Meeting Wrap-Up: Conquering Your Greatest Work Challenges
By Sharon Ambro, Co-Editor
On April 18, NEOSTC members and
guests gathered at the Clarion Hotel in
Middleburg Heights to listen to Leslie
Yerkes discuss conquering our
greatest work challenges. At the start
of the meeting, Yerkes stated that she
planned to hold the meeting using the
new philosophy of management. She
intended to guide us through the
meeting while we all worked as a team
instead of the audience just listening
to her talk.
The meeting took place in five stages
and each table of people worked
together as a team.
Stage 1 – Share your vision for
your ideal job and work environment
Yerkes stated that we spend more time
at work than anywhere else. We also
spend more time with our co-workers
than with our family and friends. As a

result, we want our work environment
to be positive and fulfilling. Yerkes
asked, “Under what conditions can
our energies be positive and can we
work to our highest purpose?” Stage 1
involved each team member sharing
with his or her team his or her answer
to this question.
Stage 2 – Perform a force field
analysis
Yerkes asked each team to examine the
driving and restraining forces that act
on our vision for the ideal job and
work environment. Driving forces
create a work environment that allows
us to make our best contribution.
Restraining forces inhibit this type of
work environment, making it difficult
for us to work to our highest purpose.
Stage 3 – Evaluate the list of
restraining forces
Yerkes asked each team to evaluate its
list of restraining forces, and then

answer the question, “Is this
restraining force within our circle of
influence to affect it?” We crossed out
those forces outside of our circle of
influence, such as office politics and
bureaucracy, and focused on those
restraining forces we had some
control over, such as office gossip
and lack of project direction. If we
minimize the negative effects within
our circle of influence, over time we’ll
have greater influence throughout the
organization.
Stage 4 – Prioritize the list of
restraining forces
Out of the restraining forces that we
can influence, Yerkes asked each team
to rate the top four forces that are
most restraining in the workplace. We
noticed several key themes among
those forces that we considered to be
most restraining. They all involve
See Challenges, page 9

